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1. INTRODUCTION

The Tritex EVA actuator includes the patented and proven Exlar inverted roller screw with integrated brushless motor plus 
electronics to provide a complete valve actuator solution, all housed in an environmentally sealed enclosure with hazardous 
area certification. 

This manual is for use with Tritex EVA080 actuators only. Installation and service instructions for other Tritex actuators can be 
found at www.Exlar.com.

The following instructions must be followed when installing Curtiss-Wright, Exlar products:
• Read all instructions before installing, operating or maintaining this product
• Contact Curtiss-Wright, Exlar for any questions
• Follow all warnings, cautions, and noted instructions on, and with the product
• Qualified personnel should install, operate, update and service the product Tritex EVA Product Page

https://www.cw-actuation.com/en-gb/products/intelligent-drive-motor-actuators/tritex-eva-series
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2. HEALTH & SAFETY CONSIDERATIONS

Safety is of paramount importance during the installation and operation of your Tritex EVA actuator. Throughout this manual, 
content flagged with the cautionary symbols shown below should be read carefully by installers and operators to help avoid 
property damage, personal injury or death.

  WARNING! 
Indicates a potentially hazardous situation which could result in serious injury or death if precautions are not taken.

  CAUTION!
Indicates the information following is necessary for avoiding a risk of damage to the product or other equipment.
Several general warnings and cautions follow. In addition, refer to the AGENCY APPROVALS section for Conditions of Use for 
additional limits and requirements to ensure safe installation and operation. 

  WARNING! General
Failure to follow safe installation guidelines can cause death or serious injury. Voltages and currents in the product can cause 
electric shock or burns and could be lethal. Extreme care is always necessary when working with or adjacent to the product. 
The installation must comply with all relevant safety legislation in the country of use. The forces created by the actuator could 
be lethal or cause severe injury if proper protection is not provided to keep personnel away from moving components. Before 
installing the actuator ensure that it is suitable for the intended application. Consult with Curtiss-Wright, Exlar if there are 
questions prior to installation. 

  WARNING! System Design & Safety for Personnel
System Design and safety for personnel. The actuator is intended as a component for professional incorporation into complete 
equipment or a system. 

  WARNING! Hot Surface – Risk of Burn
Exposed surfaces of the actuator may exceed 70 °C under normal operation and can take a long time to cool, resulting in a 
risk of burns when touched. 

  WARNING! Hazardous Area
Ensure the actuator cover is tight and properly installed before applying power to the actuator. Property damage or personal 
injury may result from fire or explosion if power is applied to the actuator with the cover removed in a hazardous area.

  WARNING! Crush/Pinch Point
Keep hands clear of stem when power applied to actuator.  
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3.  PRODUCT INFORMATION

The Tritex EVA actuator includes the patented and proven Exlar inverted roller screw with integrated brushless motor plus 
electronics to provide a complete valve actuator solution, all housed in an environmentally sealed enclosure with hazardous 
area certification. 

3.1.  PRODUCT FEATURES

Wiring access cover

Two ¾ NPT entry points

Electronics housing

Grounding (PE) point

Modbus RTU (RS-485) programming port

Motor & roller screw housing

Valve adapter faceplate 

Actuator stem
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3.2.  PRODUCT SPECIFICATIONS

Power & Control
Rated Thrust 1000 lbf (4.4 kN) 
Seating Thrust
ISO Rated Thrust

1500 lbf (6.67 kN)

Rated Speed 1 in/s (24.4 mm/s) @ 24 Vdc
Stroke 4 in (101.6 mm)
Input Voltage 12-24 Vdc ±10% nominal, 9-32 Vdc max range
Input Current 12 A max 
Idle Current 0.065 A enabled
Endurance & Life
Endurance Exceeds 10,000,000 starts, 3600+ starts per hour
Duty Class D continuous modulating, 100% duty cycle
Life (Dynamic Load Rating) 5,516 lbf (24.5 kN)
Communication & Commissioning
Serial Interface Isolated Modbus RTU (RS-485), max baud rate 38.4 k
Software Tool Free-to-download Expert PC commissioning tool
Inputs & Outputs
Digital Inputs 3 - Isolated, 9-30 Vdc
Digital Outputs 2 - Isolated, 9-30 Vdc
Analog Input 1 - Isolated, 4-20 mA, position / thrust demand

0.1% resolution, 0.5% linearity over temperature range
Analog Output 1- Isolated, 4-20 mA, position / thrust feedback

0.1% resolution, 0.5% linearity over temperature range
Environment & Mounting
Enclosure NEMA 4X, IP66
Operating temperature -40 to 149 °F (-40 to 65 °C)
Ambient storage temperature -58 to 185 °F (-50 to 85 °C)
Mounting Face mount, any orientation, with valve adapter
Noise Less than 70 dB operation
Weight 17.2 lbs. (7.8 kg)
Standards
Approvals cCSAus Class 1, Division 2, Group A, B, C, D, T5
Product standards ISO 22153, RoHS
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3.3.  LABEL & ORDERING INFORMATION

A product label is attached to each actuator under the conduit entry points.  

Figure 1 - Typical Label Specifications

Position Sensing

Sample Product Number: EVA080-100-01-B-AA-H-R-XXXX

Stroke Length

BBB D F

Rod End Thread

Actuator Series & 
Frame Size 

(EVA) AAA 

Motor | Drive

Screw Lead

CC EE G

Communication

HIJK

Options

Ordering Info

Actuator Series
EVA = Electric Valve Actuator,
Linear

AAA = Actuator Frame Size
080 = 3.1 in (80 mm)

BBB = Stroke Length
100 = 4 in (100 mm)

CC = Screw Lead
01 = 0.1 in (2.54 mm), Roller
Screw lead

D = Rod End Thread
B = Female Metric, M12x1.25

EE = Motor | Drive
AA = Standard Motor (A),
Standard Servo Drive (A),
12-24 Vdc Input

F = Position Sensing
H = Absolute Position Sensing
A = Absolute Position Sensing
on Powerloss

G = Communication
R = Standard Modbus RTU
(RS485)

HIJK = Options
NNNN = None
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4.  INSTALLATION

The Tritex EVA actuator is a complete motion system that combines a linear actuator, servo motor, and servo drive. The 
electrical to mechanical power conversion and control device are contained in the actuator. 

4.1.  PRODUCT DIMENSIONS

Tritex EVA080
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2X 3/4 NPT 
Conduit
Entry Points

4.2.  MECHANICAL INSTALLATION

4.2.1.  Mounting & Mechanical Considerations
Every effort should be made to properly align the actuator main rod to the valve stem. Any misalignment will decrease the life 
of the components within the actuator and may create problems within the application associated with misalignment such as 
rod seal leakage. 

The Tritex EVA080 can be mounted in any orientation without consideration of performance, but typically the actuator is 
mounted vertically, rod end down.

4.2.2.  Lubrication Requirements
The actuator is shipped from the factory fully greased and ready for installation. Typical applications will not require 
relubrication during the life of the actuator.   Exlar recommends using Tribolube 12T, a high performance, extreme-pressure 
grease. The unique physical properties of the synthetic base oil provide outstanding protection against wear, rust, corrosion 
and high or low-temperature degradation. Tribolube 12T allows for very low starting and running torque values. 

4.2.3.  Actuator Cover Removal
There are 8 captured bolts on the cover, M8x 1.25, must be tightened to 108 in-lbs., (12.2 Nm).   Add 1 in (2.54 mm) clearance 
for cover removal and wiring. Always replace cover before applying power in a hazardous location. The clearance distance is 
only for cover removal. It is recommended to leave enough room for electrical installation and applicable guidelines followed. 

4.2.4.  Actuator Mounting Bolts
The actuator is mounted to the valve adapter using 4 bolts, ¼-20 UNC-2B, equally spaced and must be engaged at a minimum 
of 0.5 in (12.7 mm) and must be tightened to 62 in-lbs. (7 Nm). 

4.2.5.  Conduit Entry
The actuator includes 2 conduit entry ports threaded ¾” NPT. Conduit or cable glands should be tightened to 2-3 turns past 
finger tight or to ~54 in-lbs. (~6.1 Nm) of torque. Remove any transit plugs and seal unused entry points with threaded plugs.

NOTE: Power and signal wiring should be routed through different conduit entry points.   If power and signal wires are routed 
through the same conduit entry point the plastic cap lug should be discarded and replaced with an approved plug and a 
minimum of five threads of engagement.

NOTE: Use of specialty seal tapes or thread sealants to help prevent galling, seizing, and corrosion.

If the actuator is installed in a hazardous area only appropriately certified conduit, seals, and cable glands should be used. Any 
unused entry points must be sealed with certified threaded plugs without the use of an adapter. 
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         CAUTION!
Excessive side load on the actuator output rod will dramatically reduce the life of the actuator and should be avoided. Side 
load can result from misalignment or loading that is not in line with the actuator output rod.

   CAUTION!
Care should be taken not to exceed the physical travel limits of actuators. Doing so will cause the actuator to end-crash 
internally. End crashes can physically damage the roller screw and the internal components of the actuator.

CAUTION!
If the actuator is mounted with the rod end facing up, it must be external protected from exposure to rain.   The actuator is 
provided with a rod seal which has been tested to NEMA 4X enclosure ratings however long-term wear or misalignment can 
cause degradation of the seal and eventually lead to moisture ingress.

4.3  ELECTRICAL INSTALLATION

4.3.1.  Electrical Installation
Connections to the actuator are made using the two ¾” NPT entry ports defined in the mechanical installation section (Conduit 
Entry 4.2.7). Typically, one port is used for input power wiring while the other entry port is used for control wiring. The terminal 
blocks can be accessed by removing the cover (procedure defined in mechanical installation section (Actuator Cover Removal 
4.2.5).

WARNING! 
For hazardous locations, install wiring and/or cable glands 
that are suitable for the environment.   Environment examples 
include hazardous locations, ingress protection, and 
temperature. Failure to use suitable components may results 
in personal injury or property damage from fire or explosion. 

Wiring connections must be made in accordance with the 
local, regional, and national codes that apply to the hazardous 
area approval. Failure to use suitable components may results in 
personal injury or property damage from fire or explosion.

4.3.2.  Power Source
The power source nominal voltage is 12-24 Vdc. The maximum operating range is 9-32 Vdc.   The power source can be a 
battery or a DC power supply. If a power supply is used either a regulated or non-regulated supply can be used, if the above 
ranges are always maintained. Regulated power supplies typically have built in protections such as over current or overvoltage 
and are recommended.    

2X 3/4 NPT 
Conduit
Entry Points
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4.3.2.1.  Grid Power Supply
The maximum current required from the power supply is dependent on three factors: supply voltage, thrust required to 
operate the valve and the operating speed. Speed limit is a setup parameter within the actuator. The charts below show the 
maximum (peak) power supply current draw for various force and speed combinations for 12 Vdc and 24 Vdc supplies. Since 
the maximum speeds only occur for a short period of time which is dependent on speed and stroke distance, the peak input 
current draw is also for a short time, it is not a continuous value. When selecting a power supply, assure that it can supply 150 
-200% of the maximum current needed for the required time to be sure abnormal conditions do not cause the power supply to 
fault.

Power Supply Sizing Example
The example valve requires no more than 500 lbf (2.22 kN) seating thrust and the desired close speed is 0.5 in/s (12.7 
mm/s). The ISO 22153 standard for a linear valve load profile states that the seating thrust should account for the last 10% 
of the travel and the average thrust should be 30% of seating thrust.  So, in this example using 500 lbf seating thrust, the 
average thrust will be 250 lbf.  The seating thrust amps should be used to ensure the power supply has a peak available amp 
but ill not represent total amp draw. Using the graph below a 500 lbf seating thrust requires a power supply with 2.6 Amps 
available. Some power supplies provide overload Amps.  The typical power supply overload Amps can be used for seating 
thrust purposes.  The 250 lbf average load thrust should be used to select a power supply’s rated Amps.  In this case that is 
approximately 1.24 amps. The power supply must be rated above 1.24 amps and provide and current overload or rated current 
above 2.6 amps.

Figure 2 - Input Current Requirements at 24 Vdc
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Valve Application Typical Current Requirements 
The example above provides guidance for selecting a power supply.  Additional current draw testing has been conducted using 
the ISO 22153 valve thrust load provide where 10% of the stroke is at seating thrust and 90% of the stroke is at 30% of seating 
thrust.  The chart below shows the measured current draw for different seating thrusts at different valve closing speeds.  Using 
the example above of 500 lbf seating thrust a 3 in stroke move at 0.5 in/s valve closing speed would require 1.08 amps total to 
close / open the valve. 

Figure 3 - Input current requirements at 12 V
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4.3.2.2.  Battery and Charging Supply Systems
The Tritex EVA080 is designed to work with a battery and charging system. With a battery system there is typically less 
concern about the maximum (peak) current drawn, as batteries can supply high current, but more concern about the average 
current draw. The peaks from the chart below only occur during valve seating or unseating. The current required for holding 
a given thrust is about 30% of the zero speed or modulating current shown in the chart. To keep the input current as low as 
possible on battery systems with solar charging set the actuator speed to the maximum allowed by the available voltage.  

Ripple Voltage from battery charging system is a factor that needs to be considered. The maximum peak ripple voltage 
allowed is 36 Vdc peak. Any instantaneous voltage above 38 Vdc will cause the Tritex EVA080 to fault out on High Voltage 
Fault.   
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Figure 6 - Tritex EVA080 Wiring Overview

4.3.3.  Connecting to Terminals
Connections made to the Tritex EVA are made with tool-free lever-lock terminals. To make a connection, flip the lever lock on 
the desired terminal with your finger.   The lever will lock open.   Insert the conductor into the terminal (conductors should have 
an anti-splaying method applied such as ferrules, crimples or other methods). Once inserted, with a finger, actuate the terminal 
to the close position to clamp the conductor in place.   One conductor per clamping unit is recommended. 
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Optionally, if isolation of digital IO is not required terminals 1 (V RTN) and 2 (V+) are internally connected to J1 Input Power. 
This is the factory recommended way to provide power to the IO (terminals 5 – 9) when isolation of digital IO is not require.

Figure 7 – Tritex EVA080 Internal Power Jumper Wiring Overview
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Internal Ground Connection

External Ground Connection

Figure 8 - Ground wire size should be a minimum of 14 AWG and not smaller than the DC +/- power wires.

Description Location Terminal #
DC Power - J1 1
DC Power + J1 2
PE  Screw Terminal
4-20 mA OUT - J2 1
4-20 mA OUT + J2 2
PE J2 3
4-20 mA IN - J2 4
4-20 mA IN + J2 5
PE J2 6
RS485- J2 7
RS485+ J2 8
VRTN J3 1
V+ J3 2
IO- J3 3
IO+ J3 4
Output 2 J3 5
Output 1 J3 6
Input 3 J3 7
Input 2 J3 8
Input 1 J3 9

4.3.3.1.  Ground Connections
Internal and external grounding terminals are provided.  For the internal connection the ground wire is intended to be run 
through the conduit and connected to ground near the power source or in the power panel. The second ground connection is 
external and is intended to provide a local ground connection.
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CAUTION!
Ground conductors must be installed before power is applied. 

4.3.3.2.  Power Supply Wiring & Fusing

CAUTION!
Reversing polarity of the Power (+) and Power Common (-) will cause a short circuit, which must be protected by the external 
fuse. See fusing details below. If the proper fuse is not installed the actuator could be permanently damaged.

If the application does not require maximum power, and the power source is a UL Recognized power supply with current 
limiting protection the wire gauge can be reduced with a corresponding reduction in fuse rating. The power supply connections 
are a tool-free lever-actuated connection. Use fingers to open the terminal connection. Insert power wires and closing levers 
with securing the wires.

WARNING! 
If the wire gauge for power wiring is reduced the fuse Amp rating must also be reduced in accordance with wire size and local 
regulations.

Power Input Fuse Conductor
12-24 Vdc 15 Amp Bussmann KTK

R Class CC or equivalent
14 AWG (2.5 mm²) 105 °C min.
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Grounding
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Internal Power
Supplies and 
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              Figure 9 - Power Supply Wiring                                         Figure 10 - Power supply wiring example

WARNING! 
All installations should provide a method of removing the power source during an emergency shutdown condition. 
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Figure 12 - Connection to the low side controller
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Description Specification
Input Range 2 - 22.5 mA, Loss of Signal Condition <2.0 mA
Voltage Drop @ 20 mA 9 V typical
Input Resolution >14 bits over 4-20 mA range (1.6 Amps DC value / uA)
Update Rate 0.5 ms

Analog Input Specification (4-20 mA)

4.3.3.3. Control Wiring
The I/O on the Tritex EVA080 includes one 4-20 mA input, one 4-20 mA output, three digital inputs, and two digital outputs. 
All I/O circuits are isolated from each other as well as all other actuator I/O, ground, and commons. Analog and digital input 
/ output connections use tool-free terminal blocks, which can be easily manipulated by hand. Control terminal blocks accept 
26-14 AWG wires.

4.3.3.3.1. Analog Input Connections (4-20 mA)
The 4-20 mA input is a two-wire circuit. A small amount of power from the 4-20 mA signal is used to generate the internal 
power supplies needed for the isolation of the input section. This allows the input to float with the transmitter or loop power 
supply without inference from the other actuator grounds or commons. The power supply starts up when the input reaches 2 
mA. When the 4-20 mA loop is unpowered, the software reads an off-scale value (defaulted to 2 mA low trip and 30 mA high 
trip) that should be configured to indicate a “Loss of Signal” condition.
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Figure 11 - Connection to the high side controller
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4.3.3.3.2. Analog Output Connections (4-20 mA)
The 4-20 mA output is a two-wire circuit; it requires an external loop supply of 12-30 Vdc to generate the isolated supply 
voltages needed. The Tritex EVA circuit requires 8 V to operate; therefore, the max impedance the output can drive 
is dependent on the loop supply voltage. If the actuator is powered down, the output goes to an off-scale low output 
approximately 2 mA.
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Figure 13 - Examples of digital IO field wiring
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Analog Output Specification (4-20 mA)

4.3.3.3.3. Digital Input (DI) & Digital Output (DO) Connections
All the Tritex EVA I/O are optically 
isolated from the main power supply 
and each IO section is isolated from 
each other. All the digital inputs have 
a common return connection at the 
IO- terminal and require a positive 
voltage on the Input terminals to turn 
on. The outputs have a common 
positive connection at the IO+ 
terminal and produce a positive 
voltage on the Output terminals 
when they are on.   
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4.3.3.3.4.  Digital Input Specifications 

Description Specification
Input Voltage 0-30 Vdc
On State Voltage Range 8-30 Vdc
Off State Voltage Range 0-7 Vdc
On State Current
  10 V (min)
  24 V (nominal)
  30 V (maximum)

3.5 mA
5.1 mA
5.7 mA

Nominal Impedance (24 V) 4.8 kΩ
Off State Current (max) 3.5 mA
Update Rate 1 ms (typical)

Description Specification
Operating Voltage Range 0-30 Vdc
On State Maximum Continuous 
Current

100 mA

On state voltage drop @ 50 mA 0.5 V (typical)
Short Circuit Protection (auto reset) 0.5 A
Update Rate 1 ms (typical)

4.3.3.3.5. Digital Output Specifications

4.4. COMMUNICATIONS 
Modbus RTU (RS485) communications with the Tritex EVA are used for setup of the actuator. 
 

4.4.1. Modbus RTU (RS485)
Serial communication to the actuator is provided through RS485 terminals located on the Tritex EVA control board. The serial 
interface is two wire opto-isolated Modbus RTU (RS485) network. The actuator supports the Modbus RTU protocol for access 
to all drive parameters (see Software Manual for Tritex Actuators found on www.Exlar.com). The Default baud rate is 19.2k. 
The default Modbus address is 1.

1 3

42

Figure 14 - M8 Communications Connector

Connector - Front View

Hazardous Area Explosion 
Hazard. Do Not Connect 

or Disconnect When 
Energized

WARNING !
WARNING! Cap must be on when flammable gases are present. Used for 

Setup only.  Cap should be tight during normal operation.

WARNING!  Hazardous Area Explosion hazard do not connect or 
disconnect when energized
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Figure 15 - Connecting multiple Tritex EVA actuators to Modbus RTU (RS485) master host

4.4.2. PC Communication (Connecting to the Actuator)
When using the Expert software for setup and diagnostics, a Modbus RTU (RS485) converter is required to interface between 
one of the PC communication ports and the actuator. This can be a USB to Modbus RTU (RS485) converter, such as the Exlar 
CBL-T2USB485-M8-006 (6 ft length) or CBL-T2USB485-M8-015 (15 ft length) any other standard Modbus RTU converter.

Modbus RTU (RS485) is a multi-drop network, so multiple devices, some of which might not be Tritex EVA actuators, may 
be connected to a single Modbus master. Devices on any single network need to have unique Modbus Device ID’s before 
connecting them to the network. To avoid multi-drop address collisions, Exlar recommends to set all units in normal operation 
to a Modbus device address other than 1.  Any spares can be added as address 1 and later changed to an appropriate 
operational address. Since multiple masters are not supported, it is recommended to configure units using Expert software 
before final installation.

Because Modbus RTU (RS485) at speeds supported on Tritex EVA cannot be considered a high-performance link, data 
throughput and latency issues will limit the capabilities of Modbus RTU (RS485) as a multi-drop network. Due to biasing 
resistors at each node and data throughput limitations, the maximum number of devices on a network should not exceed eight. 
A multi-drop network can be useful for reporting status and changing parameters dynamically for different valve positions, or 
for providing a single access point for Expert software connection.

Function M8 Pin Number Wire Color TTCOM J7 Terminal 
RS485+ 1 Brown 6
RS485- 3 Blue 5

RS485 COM 4 Black 4
PE 2 Drain 3

 EVA080
# n

(8 max)

EVA080
# 2 

EVA080
# 1 

Modbus Master
PC, HMI, PLC etc.

485+ 485-  Ref
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DO NOTCAUTION:
CIRCUIT IS LIVE

DISCONNECT WHEN!

4.4.2.1. CBL-T2USB485-M8-xxx Communication Cable
xxx = cable length in ft. Available lengths are 6 (006) and 15 (015) feet. 

Exlar offers a USB to Modus RTU (RS485) converter with an M8 connector ready to connect to the Tritex EVA080 port. Model 
# CBL-T2USB485-M8-xxx. This converter is not isolated and is not recommended for permanent installation.

Description Specification
Contact Carrier Material / Color Nylon or PUR / Black
Molded Head Material / Color Thermoplastic PUR / Yellow
Contact Material / Plating Brass / Gold
Coupling Nut Material / Plating Brass / Nickel
Rated Current 2.0 A
Rated Voltage 125 Vdc
Outer Jacket Material / Color PUR / Black
Conductor Insolation Material PVC
Number of Conductors 3x24 AWG
Drain / Shield 26 AWG Drain / Foil
Temperature Range -40 °C to +105 °C (-40 °F to +221 °F)
Protection Class Meets NEMA 1, 3, 4, 6P & IEC, IP67
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NOTE: If another master is on the network such as PLC or HMI, this converter must be removed from the Modus RTU 
(RS485) end. Leaving it connected with the USB end unconnected will load down the Modus RTU (RS485) network and not 
allow it to function.

 

 
 

DO NOTCAUTION:
CIRCUIT IS LIVE

DISCONNECT WHEN!

Figure 16 - CBL-T2USB485-M8-xxx

4.5. POSITION TRACKING ON POWER LOSS
This optional feature allows the position tracking of the actuator to be maintained during power off, so if a seeking valve close 
(calibration) is not desired on power up the saved position can be used. The actuator position is tracked by a battery backed 
counter that monitors the actuator position while the backup battery voltage is present. 

Model Part Number Parts Included
EVA080 84095 Absolute positioning on power-loss battery assembly

Battery life information:
The battery can provide power to counter for approximately 10 years of power off time, or shelf life. In operation with power 
applied 100% of the time, with an average internal operating temperature of 80 °C the expected battery life is 15 years.

Low Battery Warning:
A battery voltage warning is generated when the battery voltage falls below at 3.2 V.  The Low Battery Warning will not keep 
the actuator from operating. If power loss occurs and battery voltage has fallen too low to maintain the position memory during 
a power failure a seek close calibration can automatically be performed on the next power up and the actuator will operate 
normally, if selected in startup options.

Figure 17 - Absolute Positioning on Power-loss Battery Assembly,  
Exlar Part Number 84095
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4.6. EXPERT PC TOOL QUICK START

4.6.1. Quick Start Guide – Generic Lite
The following guide provides a concise step-by-step procedure to setup a typical control valve using the Generic Lite application 
profile and does not describe all the features the Expert software is capable of. For a complete explanation of functions see the 
Exlar Software Manual found at www.exlar.com.

1. Step One – Creating an application

a. Open the Exlar Expert Software
b. Under the “File” drop-down menu, select “New” > “Application”

c. Select “EVA080” and then “Generic Lite”
d. Enter a name for the application. It is 

recommended that the name define 
the location or some other identifying 
information for the application 
installation. 

e. Enter the application author 
f. Click the “OK” button

2. Step Two – Communicating with the actuator  
(Modbus RTU)

NOTE: Before proceeding ensure the proper drive is 
installed for the Modbus RTU (RS485) to USB adapter.

a. Under the “View” drop-down menu, select “Network 
Communications Manager”
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b. In the Network Manager window, press the “Remove Network” button, then the  “Add Network” button

c. The Tritex EVA is only compatible with the default “ModbusRTU”.  Press the OK button.

d. In the MODBUS Network Properties menu default values in the “General” tab can be used for establishing 
communications with the Exlar Modbus RTU adapter for configuration purposes.   Navigate to the “RS485 Serial” tab
i. Use the Communications Port Name drop-down menu to select the COM port associated with the USB to Modbus 

RTU (RS485) serial adapter.
ii. Click the “OK” button.

       

e. Click the “Scan Network” button. The status should now show “CONNECTED” and the Network Manager window can 
now be closed.
i. If not; ensure the correct COM port is selected.
ii. Or check the USB to Modbus RTU (RS485) adapter is functioning correctly.
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NOTE: For issues with connecting to the actuator ensure the drive is installed for the Modbus RTU (RS485) to USB 
adapter. 

                         

3. Step Three – Setup

a. Click the upload from drive button found on the menu bard. This will read the parameters stored in the actuator to the 
Expert PC tool.  

 

b. Select the “User Units” page in the System Panel under “Setup”.
i. Select the “Inches” or “Millimeters” icon to set the displayed linear units.
ii. In the Output Current drop-down menu select “Percent” or “Amps” 

1. Percent is recommended as it displays a percentage of the output current being supplied to the motor. Selecting 
Amps will show the output current, in Amps, supplied to the motor from the drive internally. 

       NOTE: This is not related to the input current supplied to the actuator via the J1 terminal.
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c. Select the “System Setup” page in the System Panel under “Setup”.
i. The Options tab defaults are suitable for typical valve setups.
 1. Auto-Enable on Start-up - When powered the actuator will immediately be ready to move
 2. Auto Home on Enable - When enabled the actuator will self-calibrate (if not calibrated)
ii. While not required; changing the Drive Name can be particularly useful for installations connecting multiple Tritex 

EVA actuators on the same Modbus RTU (RS485) network. Once a new name is defined, click “Save drive name”.

   WARNING! Crush/Pinch Point
Keep hands clear of stem when power applied to actuator. The actuator may conduct a calibration routine if Auto-Enable on 
Startup and Auto Home on Enable are configured. 

 
d. Select the “Fault Enable” page in the System Panel under “Setup”.

i. Fault Flags – The check box defines how the actuator will respond to the various drive/motor faults.
ii. Communications (RS485) – Define how the actuator will respond to the various Modbus RTU (RS485) faults.
iii. FAULT MOVE – Defines the position of the actuator once the FAULT MOVE fault flag becomes active. FAULT 

MOVE position is generally used on battery backup system to move to a fail-safe valve position (open, close, other) 
under user defined conditions (power loss, signal loss, etc.). Typically, the “0” position is the Valve Closed position. 

NOTE: The FAULT MOVE has priority on all operating modes. 
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NOTE: The FAULT MOVE requires the actuator to be homed before a FAULT MOVE can be executed. 
 

e. Select the “Limits” page in the System Panel under “Setup”
Limits are used to define limit of the maximum value of each parameter.   Adjusting limits can be used to protect the 
actuator or attached equipment.   The defaults are suitable for typical valve applications.

NOTE:  A 0 value in any of these fields disables the limit 

i. Low Bus Voltage Limit – This limit is typically configured for actuators installed with a battery backup system to 
avoid unwanted faults. 
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f. Select the “Operating Modes” page in the System Panel under “Setup”.

The Operating mode defines the default and alternate operating modes. The Default Mode defines the operating mode 
under normal conditions while the Alternate Mode is only active if the Alternate Mode Active flag is high.

i. Digital Inputs – Allows for the execution of 4 move profiles defined in the Motion > Motion Setup page, Move Tab.  
ii. Analog Position – Allows for position control for a 4-20 mA source.   While Analog Mode is active the actuator will 

continuously move to the position command defined in the Motion > Motion Setup page, Analog Position Tab.

NOTE: In the case that multiple signal types are present (example: Digital Inputs and 4-20 mA Analog) whichever is 
defined under the Default will take priority. 
NOTE: The Alternate Mode flag can be assigned to a Digital Input or by a Modbus RTU (RS485) command.

g. Select the “Position Limits” page in the System Panel under “Setup”.

The Position Limits page is used to setup the actuators valve seating routine.   This page should be setup to the 
using the installation application requirements.   For a detailed explanation of the valve seating routine see the Expert 
Software Manual.

 
 

Normal
Motion

Velocity

Current
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Current

Seating 
Current

Positive Position
Limt

Limit 
Velocity

Hard Stop

Seating Time

Foldback Current

Figure 15 - Valve Seating Routing
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 Typical valve seating routine for digital input mode. 

 Typical valve seating routine for analog 4-20 mA mode.

i. Absolute Position Limits – Defines the distance or % of analog position range where the valve seating routine is 
enabled.   Enable min (-) is used for valve close and Enable max (+) is used for valve open.   

ii. Velocity – Defines the speed of the seating routine. This parameter allows for a slower valve seat to protect the 
valve.   Typical valve applications use 0.1 to 0.2 in/s velocity.

iii. Foldback Current – Once the seating routine is complete this is the value of the current to hold the valve closed. 
iv. Seating Current – Once the valve closes the actuator current will rise to this value for a configurable amount of time 

to ensure proper valve seating.      
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NOTE: The Seating Current should be adjusted to enough % to properly seat the valve.
NOTE: The Foldback Current should be adjusted to the lowest value that the valve does not leak when in the closed 
position. 
NOTE: A chart correlating output currents (includes foldback and seating currents) to output thrust/force can be 
seen in figure 15.
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4. Step 4a – Digital I/O

Step 4 is broken into 4a and 4b.   4a is for actuators primarily controlled by digital inputs, 4b is for actuators primarily 
controlled by 4-20 mA.
a. Select the “Digital I/O” page in the System Panel under “I/O”.

i. Input Assignments – Used to assign hardware inputs to actuator input functions such as closed position or open 
position. 

ii. Output Assignments – Used to assign actuator digital outputs to actuator functions such as actuator close or 
faulted.  

iii. Virtual IO – Allows an output even (such as faulted or actuator close) to set or clear an input event.   
iv. Polarity – Clicking the polarity button switches each input, output, or virtual IO to positive or negative.   Example: 

Negative polarity means the output will be off when the function is active, and on when the function is inactive. 

NOTE: This does not change the electrical characteristics of the I/O line. 
NOTE: The lowest move value takes priority in the case of more than one move command is received.     

NOTE: Valve open signal is wired to Input 1. Whenever the 24 Vdc open signal is not present, the valve will close. 
When the open signal is present, the valve will open.   This configuration allows for fail-to-close on signal loss.  

Typical Digital I/O setup for single wire control. 
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4. Step 4b – Analog 4-20 mA IO

Step 4 is broken into 4a and 4b.   4a is for actuators primarily controlled by digital inputs, 4b is for actuators primarily 
controlled by 4-20 mA.

b. Select the “4-20 mA IO” page in the System Panel under “I/O”.
       The 4-20 mA IO page is used to setup the function of the 4-20 mA analog input and output. 

i. Input Setup – Used to configure the 4-20 mA analog input signal.   For a detailed explanation see the Expert 
Software Manual              

ii. Output Setup - Used to configure the 4-20 mA 
analog output signal. For a detailed explanation see 
the Expert Software Manual.

NOTE: Analog output is typically to monitor valve 
position or monitor actuator output force (continuous 
current). 
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5. Step 5 – Comparators

Two comparators all output events to be set based on the state of the comparator outputs. The comparator output 
events are Comparator 1 and Comparator 2. The Expert Comparators function is considered an advanced function not 
used in a typical valve control application. For a complete explanation of Comparator function see the Expert Software 
Manual found at www.exlar.com.

 
6. Step 6 – Motion Setup

The Motion Setup page defines how the valve positions and how quickly the actuator will move to each commanded 
position. 

a. Select the “Move” tab in the System Panel under “Motion Setup”. 
i. This page defines the home, jog, and actuator positions.

b. Home – The Tritex EVA080 intelligent valve actuator is a servo-based solution that requires homing (calibrating) before 
regular operation (Only the “job” function works before homing)   

NOTE: Units equipped with the onboard battery for power-loss position tracking must still be homed during initial setup. 
After, the actuator will retain its position during power-loss.
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i. Direction – Defines the direction that actuator will seek to define zero.   Negative direction extends the main rod of 
the actuator and is typically the valve closed direction. The Negative default setting is recommended for the typical 
valve setup.

NOTE: Seeking home in the positive direction will alter the move positions recommended in this guide. 
NOTE: Care must be taken seeking home in the positive direction to avoid risk of damaging the valve assembly.   
Using too much homing current may pull the valve stem assembly out of the valve. 

ii. Velocity & Acceleration – Defines how fast the actuator will seek the home position and how quickly the actuator will 
achieve the defined velocity. Defaults are recommended for the typical valve setup. 

iii. Current Limit & Terminate on Current Limit – Defines the output current (output thrust) the actuator will use to define 
the home position. Defaults are recommended for the typical valve setup. 

NOTE: The Current Limit may need to be adjusted to meet the needs of the specific valve application.   Excessive 
current (output thrust) during the homing operation may damage the valve.    

iv. Home Offset – Defines the distance the actuator will move once home is found.   Using Home Offset is not required 
for typical valve setups. 

v. Final Home Position – Defines the position value of the actuator once homed.   Using the value of “0.000” while 
homing in the Negative direction will define the valve close position as “0.000”. 

 

1. Home Initiation – Home is initiated by clicking the Home button on the Input Function Control page, Modbus 
RTU, or Auto-Home on Enable.

NOTE: By default, the Input Function Control page is found on the right side the Expert Software interface. If 
closed; it can be re-opened by View > Page > Input Function Control.
NOTE: Motion will occur during the homing operation. 
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c. Move – Define the commanded positions and move behavior of the valve actuator. Move only applies to actuators 
configured for the Digital Input operating mode. The “Move” drop-down menu defines what move is being setup. 
i. Position / Distance – The value defines the position of the move.   The actuator can be configured for up to 4 pre-

defined position moves. 
1. Move 1 – Typically defined as the Valve close position. If Home final position is “0.000” it is recommended that 

Position / Distance value, be defined as “0.000”.
2. Move 2 – Typically defined as the Valve open position.   The open value should be the stroke of the valve. 

 

NOTE: Typical values for a 0.75 in stroke valve shown. 

ii. Velocity & Acceleration – Defines how fast the actuator will seek the home position and how quickly the actuator will 
achieve the defined velocity. Defaults are recommended for the typical valve setup. 

iii. Limit Current – Checking the Limit Current box will limit the actuator output current (output thrust) used to achieve 
the Move position.    

1. Terminate on current limit – This check box will stop motion if the Current Limit value is reached.    
2. Fault if terminated by current limit – This check box provides a fault flag if Current Limit value is reached. 

NOTE: The Current Limit may need to be adjusted to meet the needs of the specific valve application.   Excessive 
current (output thrust) during the homing operation may damage the valve.   

d. Jog – Jog allows for user position control of the actuator along its entire stroke.   Jog is most often used during the 
mechanical installation of the actuator to couple the valve stem to the actuator main rod or when servicing the valve.

 i. The jog velocity slide is a quick way to adjust the jog velocity without permanently saving the value to the drive.  
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e. Analog Position – Define the functioning of the actuator from a 4-20 mA analog signal or simulated Modbus RTU 
(RS485) signal.   Analog Position only applies to actuators configured for the Analog Position operating mode.
i. Analog Input Channel – Defines the source of the analog channel, 4-20 mA or Modbus RTU (RS485)
ii. Analog Command – Displays the current analog position command.
iii. Minimum Position – Typically the valve close position.   It is recommended that this value is “0.000” to match the 

Final Home Position. 
iv. Maximum Position – Typically the valve open position.   The value should be the stroke of the valve.    
v. Velocity Limit & Acceleration - Defines how fast the actuator will seek the commanded analog position and how 

quickly the actuator will achieve the defined velocity. Defaults are recommended for the typical valve setup.
vi. Limit Current - Checking the Limit Current box will limit the actuator output current (output thrust) used to achieve 

the analog position.    
vii. Modbus Source – Used to simulate analog position command through the Expert software.   

NOTE: Modbus Source is only used when the Analog Input Channel is set to Modbus Control. 
 

7. Step 7 - Download & Save
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To save the changes made in the actuator configuration process the Expert software parameters must be written to the 
actuator.   
a. Click the down arrow button above the system menu or under the Drive drop-down menu, click “Write Parameters to 

Drive”.

8. Step 8 - Monitor/Control

The Expert software is a powerful software tool that can be used monitor and control the actuator. 
a. Monitor – Used to see real-time status of the actuator position, velocity, and output current (output thrust). Additionally, 
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the IO status and actuator internal temperatures can be monitored.    

 

b. Status – The default location of this page is viewed on the bottom of the Expert software. Clicking the Status page 
toggles its view.  
i. Status – Shown as Enabled or Disabled. In order to move the actuator status must be enabled.

NOTE: The drive will automatically be enabled as long as the default checked value of Auto-Enable on Startup 
parameter remains checked. 

ii. Position – Displays the current position of the actuator.
iii. Velocity – Displays the actual velocity of the actuator.
iv. Output Current – Displays the output current (between the actuator drive and servo motor).   This value can be 

viewed as output thrust. 
v. Fault – Displays the fault status of the actuator.
vi. Warning – Displays the warning status of the actuator.
vii. Bus Current – Displays the input current from the power supply.   This can be used to read the load from supply 

power.
viii. Bus Voltage – Displays the input voltage from the power supply. 

9. Step 9 - Diagnostics

The Expert software is a powerful software tool that can be used to monitor the actuator diagnostics. 
a. Diagnostics – Used to view the detail status of the actuator internal functions. 
b. Status Log – Used to view last 10 fault history and actuator run time.
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i. Power- Up – Displays how my times the actuator has powered up.
ii. Time – Display the actuator has been powered-up in hours.
iii. Recent Fault History – Use to view the last 10 recent fault history. 

c. Scope – An advanced tool used to troubleshoot non-typical advanced applications. See the Expert Software Manual for 
an explanation of this tool.

4.7. PRODUCT MAINTENANCE
In most applications the Tritex EVA080 is a maintenance free actuator. 

4.7.1. Lubrication Renewal Procedure
1. Remove the four bolts connecting the faceplate from the front of the actuator.
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2. Remove the roller screw by turning it counterclockwise and threading it out of the cylinder. To remove the screw, it may 
be necessary to hold the roller screw cylinder to keep it from turning. Turning the shaft will help force the faceplate 
assembly to break free of its housing.

3. Use a brush to work approximately 15 cm³ (0.9 in³) of grease into the roller screw assembly. Be sure all the threaded 
surfaces of the screw assembly are covered. This can be accomplished by applying grease to a few places on the roller 
screw assembly and rotating the components repeatedly in both directions to work the grease into the assembly. 

IMPORTANT! Excess grease does not improve lubrication and requires greater torque when the motor is returned to 
operation.

4. With the actuator in the vertical position and the open end of the roller screw cylinder facing up, position the roller screw 
above the cylinder so that it is aligned axially with the roller screw cylinder.

5. Slowly turn the roller screw clockwise in quarter to half turn increments while maintaining contact with the interior 
threaded cylinder (ITC). This helps align the threads on the roller screw with the threads in the ITC. Do NOT force 
the roller screw into the cylinder. If the roller screw does not turn freely, remove it and begin again. When the screw is 
properly threaded into the cylinder, it will roll freely into the actuator. 

NOTE: When the roller screw reaches the portion of the cylinder that contains the motor magnets, it will be more 
difficult to turn because of the magnetic field of the magnets. THIS IS NORMAL. Continue to thread the roller screw 
into the cylinder until it reaches the bottom (it will become difficult to turn and the motor and bearings will begin to rotate 
with it.

6. Place a small amount of seal lubricant on the inside surface of the seal/bushing assembly.

7. Carefully slide the faceplate over the actuator rod end while guiding the four cap screws through their respective holes 
in the rear end cap of the actuator. Ensure the faceplate seats completely and squarely on the front of the actuator. 

NOTE: The seal is a tight fit on the rod end. Use caution to avoid damaging the seal on the threads of the extending 
rod. The inner surface of the faceplate provides the pre-loading for the bearings, so it is important that it be properly 
seated. Torque the four cap screws of the faceplate assembly to 12.2 Nm (108 in-lbs) rotating between bolts in a star 
pattern.

4.7.2. Seal Maintenance
Exlar recommends that the faceplate assembly containing the main rod seal and bushing assembly be replaced during the 
re-lubricating procedure. To have this service performed for you, contact the Exlar Returns Department to send your unit in 
for service. If any additional maintenance or repair is needed, consult Exlar. It may be necessary to return the actuator to the 
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M6x25 SHCS Stainless Steel; Torque 108 in-lbs (12.2 Nm)

Roller Screw

Figure 19 - Lubrication Renewal Procedure Reference

factory or an authorized repair center for refurbishment.

4.8 INSPECTION, TRANSPORTATION, & PRODUCT STORAGE 

Inspection | Transportation
Before unboxing carefully inspect box for shipping damage.  Damage to the shipping box is a strong indicator that it has 
received rough handling during the shipping process. Please report all damage to the shipping box to the freight carrier and 

Faceplate Model Part Number Parts Included
  EVA080 83536 Faceplate, O-ring, 

bushing, seal, wiper, 
and fasteners
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local distributor.  

During unboxing take care to avoid damage and save shipping box and packing material in case a return is necessary. Verify 
that the items on the external box label, product label, and customer documentation matches.  

Product Storage
If the Tritex actuator cannot be installed immediately store it in a clean, dry place until ready for installation. 

If the actuator is unboxed and installed but not yet wired it is recommended that the plastic transport cable entry point plugs be 
replaced with suitable sealed plugs that comply with location requirements. 

The sealed electrical compartment and stem seal will protect the actuator components in accordance with NEMA 4X and IP66 
environments.  Curtiss-Wright, Exlar cannot accept responsibility for damage to the actuator once installed on-site.  Each 
Tritex EVA has been fully tested at the factory and will provide years of trouble-free operation as long as the cover is properly 
re-installed after wiring and cable entry points are properly sealed. 

4.9. PRODUCT RETURNS

1. Before requesting an RGA number, please contact Exlar Technical Support to see if it is possible to resolve the issue 
prior to return.

2. If it is determined that an RGA number is required, please do so by completing an online RGA request form found 
on the Exlar website. For international repairs, closely follow instructions provided by the Exlar Returned Goods 
Administrator. Failure to comply with issued instructions may result in delays for repair and return.

4.10. CERTIFICATIONS & COMPLIANCE
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Certificate of Compliance 
 

Certificate: 70060591 Master Contract: 163694 

Project: 80163757  Date Issued: 2023-11-17 

Issued To: Exlar Corporation 
 18400 West 77th St 
 Chanhassen, Minnesota, 55317 
 United States 

 
               Attention: Robert Schulz 

 
The products listed below are eligible to bear the CSA Mark shown 

    
 

 

 
 

 

 
 

 
 

 
Issued by: 

 
Steven Simkevitz 
Steven Simkevitz 

 

 
 
PRODUCTS 
CLASS - C322802 - VALVES Actuators - For Hazardous Locations  
 
Class I, Div.1, Gr. C and D 
 
Explosionproof Linear Actuator Model EXA090, Input rated 12-24 Vdc, 12A max., 1000 lbf. Output force, -40°C 
≤ Ta ≤ +65°C , T5; Type 4X; 
Three inches travel distance with a speed of 1 inch/sec at 24Vdc and continuous duty. 
 
Notes:  
1. Actuator assemblies are intended for use as components in end-product stationary equipment the suitability of 
the combination is determined by CSA Group. 
2. Input voltage comes from a class 2 circuit. The class 2 circuit is not a part of the scope of this project. 
3. This product is not evaluated to be used as the safety valve actuator.  
4. The instruction manual of the product shall indicate that a Certified input Fuse is to be installed by the end user. 
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CLASS - C322802 - VALVES Actuators - For Hazardous Locations  
CLASS - C322882 - VALVES Actuators - For Hazardous Locations-Certified to U.S. Standards  
 
Class I, Division 2, Groups A, B, C and D; T5; 
 
Nonincendive (Non Arcing/Non Sparking) Linear Actuator Model EVA080, Input rated 12-24 Vdc, 12A max., 
1000 lbf. Output force, -40°C ≤ Ta ≤ +65°C; T5 
Three inches travel distance with a speed of 1 inch/sec at 24Vdc and continuous duty. 
 
Notes:  
1. Actuator assemblies are intended for use as components in end-product stationary equipment the suitability of 
the combination is determined by CSA Group. 
2. This actuator assembly model EVA080 has not been evaluated for use in damp and wet locations. 
3. Input voltage comes from a class 2 circuit. The class 2 circuit is not a part of the scope of this project. 
4. This product is not evaluated to be used as the safety valve actuator.  
5. The instruction manual of the product shall indicate that a Certified input Fuse is to be installed by the end user. 
6. Model EVA080 has an external connector used for RS-485 communications to setup the equipment. It is not to 
be used during normal operations and is for initial configuration only. Do not connect or disconnect when the 
equipment is energized. 
 
 
APPLICABLE REQUIREMENTS 
 
Explosionproof Linear Actuator Model EXA090: 
CSA C22.2 No 139 - 2019 - Electrically Operated Valves 
CSA C22.2 No. 30:20, Update No. 
1 March 2023 

- Explosion-proof equipment 

CAN/CSA-C22.2 No.94-
M91(reaffirmed 2011) 

- Special Purpose Enclosures 

 
Nonincendive (Non Arcing/Non Sparking) Linear Actuator Model EVA080: 
CSA C22.2 No 139 - 2019 - Electrically Operated Valves 
CSA C22.2 No. 213-17, 
Reaffirmed 2022, Third Edition 

- Nonincendive Electrical Equipment for Use in Class I and II, Division 2 and 
Class III, Divisions 1 and 2 Hazardous (Classified) Locations 

UL 429, Seventh Edition, With 
Revisions March 19, 2021 

- Electrically Operated Valves 

UL 121201, Ninth Edition, With 
Revisions April 1, 2021 

- Nonincendive Electrical Equipment for Use in Class I and II, Division 2 and 
Class III, Divisions 1 and 2 Hazardous (Classified) Locations 

 
 
MARKINGS 
 
The manufacturer is required to apply the following markings: 

• Products shall be marked with the markings specified by the particular product standard. 
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• Products certified for Canada shall have all Caution and Warning markings in both English and French. 
 
Additional bilingual markings not covered by the product standard(s) may be required by the Authorities Having 
Jurisdiction.  It is the responsibility of the manufacturer to provide and apply these additional markings, where 
applicable, in accordance with the requirements of those authorities. 
 
The products listed under class 3228-02, model EXA090 is eligible to bear the CSA Mark shown for Canada 
only. Refer to label drawing 69153. 
 
The products listed under class 3228-02 and 3228-82, model EVA 080 is eligible to bear the CSA Mark shown 
with adjacent indicators 'C' and 'US' for Canada and US (indicating that products have been manufactured to the 
requirements of both Canadian and U.S. Standards) or with adjacent indicator 'US' for US only or without either 
indicator for Canada only. Refer to label drawing 84142. 
 
Markings as follows appear on an aluminum nameplate using printing photo anodized aluminum technology, 
attached by 4 screws to the enclosure: 
 
- Manufacturer’s name: Exlar name, trademark, or the CSA file number (adjacent the CSA Mark). 
- Date code / Serial number traceable to month and year of manufacture. 
- Catalogue / Model designation: 
- Complete electrical rating (amps and volts). 
- Hazardous locations designation; 
- Temperature Code; 
- Ambient Temperature; 
- The CSA Mark. 
Note: applicable warnings are dependent on the specific model. 
Model EXA090 (Explosionproof): “CAUTION –  DO NOT OPEN WHEN EXPLOSIVE ATMOSPHERE IS 
PRESENT” and “ATTENTION – NE PAS OUVRIR EN PRÉSENCE D’UNE ATMOSPHÈRE EXPLOSIVE” 
Model EVA080 (Nonincendive (Non-arcing/Non-sparking)): “WARNING – EXPLOSION HAZARD. DO NOT 
CONNECT OR DISCONNECT WHEN ENERGIZED” and “AVERTISSEMENT – RISQUE D’EXPLOSION. 
NE PAS BRANCHER NI DÉBRANCHER SOUS TENSION” as well as “WARNING: DO NOT OPEN WHEN 
AN EXPLOSION ATMOSPHERE MAY BE PRESENT”, and “AVERTISSEMENT: NE PAS OUVRIR SI UNE 
ATMOSPHERE D'EXPLOSION PEUT ETRE PRESENTE” 
-Maximum output force; 
- “3/4” NPT Conduit Entries” 
- “Conduit entries shall be sealed within 18 inches of the enclosure.” (Model EXA090) 
- “For Supply Connections, Use Wires Suitable for at least +90 °C (194 °F) 
 
Additionally, items may appear on a Brady B486 metallized polyester adhesive film label manufactured by Brady 
Worldwide Inc. CSA accepted label and tested previously under project 1538184. 
 
 
Notes: 
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Products certified under Class C322802 have been certified under CSA’s ISO/IEC 17065 
accreditation with the Standards Council of Canada (SCC). www.scc.ca 
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Supplement to Certificate of Compliance 
 

Certificate: 70060591 Master Contract: 163694 

The products listed, including the latest revision described below, 
are eligible to be marked in accordance with the referenced Certificate. 

 Product Certification History  
 
Project Date Description 

80163757 2023-11-17 Project to update report 70060591 to evaluate: i) Changes to the ELT090 
model with Class I, Division 1, Groups C and D construction consisting of 
model name change (ELT090 to EXA090), update to latest edition CSA 
C22.2 No. 30:20, evaluation of a new consolidated PCB board, new dowel -
located outside of the flamepaths, removal of an optional metal plug, 
change to the thermal sensor for the motor and minor constructional 
changes. 
ii) Add a new model EVA080 for Class I, Division 2, Groups A, B, C 
and D for Canada and the United States. The EVA080 has a similar 
construction to the EXA090 and share a common PCB.  
iii) Removal of standard CSA C22.2 No. 0-10, General requirements - 
Canadian Electrical Code, Part II. 
iv) Removal of standard of standard CSA C22.2 No. 0.4-04, Bonding 
of Electrical Equipment. 
 

70113600 2017-01-10 Update the report to make correction to the class number on the CofC. 
 

70060591 2016-06-30 Certification for CAN of ELT090 actuator for Class I Div.1 Gr.C and D,  
T5, Type 4X enclosure 
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